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Introduction

What is Aqua4Plus?

Aqua4Plus is INW’s easy-to-use Windows-based software for communicating with and
controlling INW’s state-of-the-art Smart Sensors.

Aqua4Plus is designed as a multi-layered control program. The program can control a
number of separate sensors, via cable, radio, modem, or some combination of the three.
Aqua4Plus communicates with INW Smart Sensor using the industry standard
Modbus® communication protocol.

Smart Sensors collect and store data in “sessions.” A session is a preprogrammed series
of steps describing the number of samples to record and the intervals at which samples
are taken. The Aqua4Plus software is used to create and store the sessions to the
sensors and to upload, view and export the collected data.

System Requirements

• Desktop or  laptop computer, running Windows 98 or higher.
• 64 MB RAM
• 10 MB free hard drive space
• CDROM drive (Floppy version available on request.)
• 9-pin serial port (See Application Note usb_serial-9C0153.pdf for USB alterna-

tives. This application note is supplied on the enclosed CD.)
• 56K V.92 modem - if using a modem version of Aqua4Plus

About this Manual

This manual contains in-depth instructions on basic aspects of using Aqua4Plus,
including initial setup, controling the sensors and retreiving data.

The CD in the back of this manual contains additional instructions for advanced
features and special circumstances.
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Connecting a Sensor to the Computer

In its cabled configuration, the Smart Sensor cable is terminated with a waterproof
connector.  In its free-suspension configuration, the sensor is terminated with a screw-
cap. Remove the screw-cap to access the waterproof connector. Connect the water-
proof connector to your PC or laptop serial port via the interface cable and an RS485/
RS232 adapter, as shown below. For USB connections, see Appendix C.

Figure 1: Connecting a Sensor to the computer
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Installing the Aqua4Plus Software

1. Insert the Aqua4Plus CD in the CDROM drive on your PC or laptop. Installation
should start automatically. If not, then follow steps 2 and 3. Otherwise, skip to
step 4.

2. Click the Start button and select Run.
3. Type D:\setup.exe, where D: is the drive letter for your CDROM drive.
4. The Installation program will guide you through the installation process.

Once the software has successfully completed installation, you can remove the CD from
your CDROM drive and store it in a safe place.

To start the Aqua4Plus software, use the Start Menu to navigate to the program group
you selected during installation (typically this will be Aqua4Plus), and then click the

Aqua4Plus  icon.
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First Time Setup

If you have just installed Aqua4Plus, please take a few minutes to go through the setup
options and configuration.

Options Menu
Use the Options Menu to control settings for the Aqua4Plus software. (Use the
Configure Menu, next page, to control settings for sensors.)

Units - Use this option to select the units in which to display
your data. This will control how data is represented on
the Real Time Monitor, the File Display Window, the
Graph Window, and for exported data.

Company Name - This name will print when printing from the File Display
window.

Default Folder - Aqua4Plus saves and looks for files in a default folder.
Use this option to select a default folder location.

Connections - This option is only available if you have a modem
enabled version of Aqua4Plus. See INW for
further details.

Communication - This option is used when communicating with a sensor
via radios or modems. When connecting directly to a
sensor (i.e., using a communication cable and not using
radios or modems), select the Direct Connect (No
modem) setting from the drop-down box for faster
communication.

- If using addresses greater than 32, be sure to set the
Lowest and Highest Sensor Addresses to include all
addresses that you are using.

Change Password - Change the password that is required to enter the
Advanced Setup Menu.

Configure Menu *

Use the Configure Menu to set options on individual sensors. Note that not all options
will be available on all types of sensors. The program determines what sensor you are
connected to and lists configuration items available for that sensor. In order to access
items on the Configure Menu, you must first connect to and select the sensor whose
configuration you want to set. (See Finding, Selecting & Viewing Sensors, page 8.)
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Sensor Clock - A pop-up box displays the date/time currently in the

sensor. Click the Set From System Clock button to set
the sensor clock to match that of your host computer.
Alternately, type in a specific date/time and click the
Set Clock button.

Sensor Description** - Use to enter a description for a particular sensor.
This information is displayed on the Sensor
Window and is recorded with the collected data.

Sensor Address** - If you are connecting several sensors to one
com port, each sensor must have a unique
address. This is also known as the Modbus address.
Use this option to set the address.

- Addresses must be between 1 and 127. If using
addresses greater than 32, be sure to set the Lowest and
Highest Sensor Addresses to include all addresses that
you are using. (See Options Menu | Communication.)

Erase All Sessions - Erases ALL sessions in the currently selected
sensor.

Field Calibration** - Use this option to adjust the calibration on the sensor.
Note that different types of sensors will have different
calibration procedures. Refer to the specific sensor
manual for information on field calibration for that
sensor.

Advanced - This submenu can only be accessed by entering
a password. If you need to use these advanced
features, contact your supervisor for the correct
password.

Download Firmware** - Downloads an updated version of the
firmware to the sensor. [Contact INW
factory personnel for details.]

Advanced Calibration** - [Contact INW factory personnel for
details.]

* Not available if there is an Active, Pending, or Paused session on the selected sensor.
** Not available if there are ANY sessions stored on the selected sensor.
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Normal Operation

Selecting a COM Port

Aqua4Plus communicates with the smart sensors via a communication or COM port on
the PC. When Aqua4Plus is first opened, it polls the computer for all available communi-
cation ports. These are then listed in the connection port drop-down box on the tool bar
(figure 6). By default, Aqua4Plus looks for COM 1 through COM 4. If you are using a
higher COM port, specify the highest COM port on the Communications dialog box
under the Options menu.

To select the COM port you  are using, click on the down arrow, and then click on the
COM port to which your sensor is connected. (Note, if you are using a modem to
connect to your sensor, there may be more options in the drop-down box.)   If you do
not have a serial port on your computer, you can use a USB port along with a USB/Serial
cable. (See Application Note usb_serial_9C0153 on accompanying CD.)

Figure 6: Connection Port Drop-Down Box

Finding, Selecting, and Viewing Sensors

Once the com port has been selected, open the Sensor Window by clicking the  tool
button  (or View Menu | Sensor Window). The software will poll the port, looking for any
connected sensors.  A list of connected sensors will appear on the Sensor Map. If
specific expected sensors do not show up, and you know their addresses, rescan just
those addresses by selecting “Scan Specific Address Range” from the View Menu.

On the Sensor Map (figure 7), double-click to select a sensor. A list of data sessions
stored on the sensor will be displayed below the sensor. Information regarding the
selected sensor will display in the Sensor Information Panel to the right of the Sensor
Map.

                            Figure 7: Sensor Map  and  Sensor Information Panel

Click here to get
additional details, as
shown below.
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Note that the information shown on the Sensor Map and the Sensor Panel is static
information. In other words, the program looks at the sensor and displays the informa-
tion, but it does not keep going back to the sensor and getting the newest information.
This is to save battery life on the sensor. To update the information on the Sensor Map
and the Sensor Panel, click on the “Refresh Selected Sensor” button below the Sensor
Map. This will requery that particular sensor and update the display.

Sensor Map:
The Sensor Map displays a list of all sensors connected to the selected com port. If no
com port is selected or no sensors are connected to that com port, this map will be
empty. The Sensor Map is an expanding tree display. Double-click on a sensor to expand
the display to show all sessions, if any, currently stored on that sensor. Click on the  to
the left of a sensor to hide the display of sessions for that sensor.

The different icons in front of each session indicate the current status of  that session,
as follows:

   Completed Session - session has run to completion or has been terminated.
   Paused  Session - session has been paused by operator.
   Pending Session - session awaiting a delayed start time.
   Active Session - session currently recording.

Sensor Information Panel:

The top right portion of the Sensor Window displays information pertaining to the
sensor that is selected on the Sensor Map. This information will vary, depending on the
type of sensor selected. Typical information may include:

Status: Current sensor status: Active, Inactive, Paused or
Pending.

Sessions: Number of data sessions stored on selected sensor.
Maximum of 60.

Power Source: Battery or Auxiliary.

Free Records: Approximate number of records that can be stored
before the sensor memory is full.

Battery: Battery indicator - if Green, the battery is good, if
Orange, it is low, if Red, it is critically low.

To view further details, click the ellipsis  in the upper right corner for a drop-down
information panel. Typical information for this drop-down panel may include:

Sensor Description: User assigned description. (Set this description on the
Configuration Menu | Sensor Description Option.)
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Sensor Type: Factory assigned sensor type.

Modbus Address: This is the assigned Modbus address for the sensor.
Each sensor on a com port must have a unique
Modbus address. This address must be between 1 and 127.
(Set this address on the Configure Menu | Sensor Address.)

Serial Number: Factory set sensor serial number.

Firmware Revision: Sensor firmware revision number.

Using the Real Time Monitor

Figure 8: Real Time Monitor

Use the Real Time Monitor (lower part of Sensor Window) to view live readings from the
sensor that is selected on the Sensor Map. These readings are not being recorded in the
sensor, but only displayed for real time viewing. The Real Time Monitor can be used
whether or not the sensor is actively recording a session.

To obtain and display a single reading, click the Single button.

To obtain and display readings continuously for 60 readings, click the Start button.

To stop the monitor, click the Stop button.

The Monitor displays a column for the sensor date/time and for each parameter being
collected. Use the horizontal and vertical scroll bars as needed to adjust the view.
Readings are displayed in the units selected from the Options Menu. For example,
pressure might be displayed in psi or in Ft  H2O, or something else. (See page 10 for
details on the Options Menu.)
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Using Sessions

The Smart Sensor collects and stores data in “sessions.” A session is a preprogrammed
series of steps describing the number of samples to record and the sampling intervals.
Several sessions can be in the Smart Sensor memory at any one time, several completed
sessions (along with their data) and one active session. An active session can be either
recording, paused, or pending. The maximum number of sessions and the maximum
number of records that can be stored depends on the type of sensor. Check your sensor
documentation for details.

The Session Profile Window is used to create and/or view session profiles. A session
profile is a description of the test steps necessary for a particular test. Session profiles
can be saved to disk for later use or downloaded to a sensor. Note: there can only be
one active session on a sensor. Once a new session is downloaded, any currently active
session is terminated and the new session becomes the active session. All previous
sessions on the sensor are retained, along with their data, until erased, but can not be
run again.

Figure 9: Session Window
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Creating Sessions:

1. Create a new session  by clicking the  tool button (or Sessions Menu | New).
A Session Profile Window will open with a new session profile.

2. If you want to open a previously saved session profile, click the  tool button
(or File Menu | Save), and then select the profile you want. If you are satisfied
with this profile, skip to step 8. Otherwise, continue with the following steps.

3. Name your session by entering a name in the Session ID box, or leave as is to
accept the default name.

4. Describe test phases. Each session consists of up to 10 test phases. During
data collection, these phases will be executed one after the other in sequence.
Each phase can have different polling intervals and/or number of records. For
example, you might want to record a reading every five seconds for 100
records, every 30 seconds for 100 records, and then every five minutes for the
next 1000 records.  The length of each phase shows in the right-hand column.
The recording length for the entire session shows at the bottom of the window.

To describe a test phase:
• Click in the Polling  Interval column for the first phase.
• Enter your polling interval for this phase as dd/hh:mm:ss, where “dd” is

number of days, “hh” is number of hours, “mm” is number of minutes, and
“ss” is number of seconds between recordings. You only need to enter the
smallest time interval you are using. For example, if you want a sample
recorded every 10 seconds, you only need to enter 10 and then press the
Tab key. The days, hours, and minutes will default to zero. Likewise, if you
want a sample recorded every hour, you would enter 01:00:00, and the
days would default to zero.

• Enter the number of records to record at this polling interval.
• Press the Tab key and continue entering phases.

5. If desired, select Delayed Start Time: Click the Delayed Start checkbox. Enter
the date and time to start. Time is in 24 hour format. This option is especially
useful when you want to collect and compare data from several sensors. Create
a profile, save it to disk. Connect to each sensor in turn and download the test
to that sensor. Note: For accurate data, be sure the clocks in all the sensors
have been set to the same time. (See page 11 for details on setting the clock.)

6. If desired, add Event Processing: Event processing allows the rate of sampling
to vary as a result of the rate of change of the sampled data. For example, you
might want to normally make a recording once every five minutes.  However, if
the pressure suddenly changes significantly, you might want to make a certain
number of recordings at a much shorter interval and then revert to normal.
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To select Event Processing, click the Event Processing checkbox.

− Select a Trigger Parameter: This is the type of data that will trigger an
event.

− Specify a Trigger Event: For example, if you chose Pressure as your
Trigger Parameter, you would enter a certain change in pressure that
would trigger the event. If you enter 1.0 psi, then if there is a change of
1.0 psi or more from one reading to the next, the event recording will
begin.

− Enter a Sample Interval to use during the event recording. This is how
often the recordings will be made during the event phase.

− Enter the number of samples to take during the event phase.

After the specified number of records have been recorded at the specified
interval, the recording reverts to normal.

(Note that event mode may use battery power more rapidly than expected,
as you have no way of knowing how often an event may be triggered,
causing frequent recordings.)

7. If desired, save the session to disk for future use: Click the  tool button (or
File Menu | Print), enter a file name or leave as is to accept the Session ID as
the file name, then click the Save button. Note: Event processing setup details
are not saved with the profile, but must be set each time before downloading
the session.

8. Download session to the sensor: Once you are satisfied with the session
profile or setup, you must download the session to the sensor. To do this, click
the Start button.  If you selected a delayed start time, the sensor will wait until
the specified time and then begin collecting data, otherwise data collection will
begin immediately.  (Note: Downloading a session to the sensor will terminate
any active, paused, or pending session.)

Pausing and Resuming Sessions:

You can manually pause and resume the active session on the sensor. To pause, click on
the active session on the sensor map. (The active session will have a green icon  in
front of the session name.) Once the session has been selected, open the Session Menu
and select Pause. A hand icon  will display in place of the green icon.

To resume a paused session, click on the paused session to select it. Open the Session
Menu and select Resume. The hand icon will once again change to a green icon. Note:
you cannot resume a terminated or finished session, one with a blue checkmark .
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Terminating a Session:

Any active session (running , paused , or pending ) can be terminated manually
at any time. On the Session Map, click on the session to select it. Open the Session
Menu, and then select Terminate. The icon will be replaced by a blue checkmark .

Erasing Sessions:

To erase the sessions and their data from the Smart Sensor, open the Config or Session
Menu, and then select Erase All Sessions. You cannot erase individual sessions.
Erasing deletes ALL sessions on the sensor. Be sure you have uploaded all important
data before erasing the sessions.

Note: The Config Menu cannot be accessed if there is an active session on the sensor.

Retrieving Data

• If the sessions are not displayed on the Sensor Map, double click on the sensor
from which you will be uploading.

• Click on the session you want to upload.
• Click the   tool button. The Save dialog box displays.
• Enter a file name or leave as is to save with the Session ID as the file name.
• Select a file type. Uploading always saves the data in the Aqua4Plus Data File

(.a4d) format. Files can also be saved in either Text (.csv) or Excel (.xls) formats.
Select the file type from the drop-down Save-as-type box. (.xls formatted files can
be opened in Excel. .csv formatted files can be opened in Excel and most other
popular spreadsheets, databases, and word processors.)

• Click the Save button.
• Click Start.
• When upload is complete:

If you uploaded in only the Aqua4Plus Data File (.a4d) format, you can now
click on the Done button to close the upload box, or you can click on the View
button to view the data in the File Display window. (See more details on the
File Display window in the next section.)
If you uploaded in Text (.csv) or Excel (.xls) format, the file will automatically
be opened in the File Display window, and you will also be given the option
of viewing it in Excel. (Note, you must have Excel installed on your machine in
order to make use of this option.)

Viewing Data

Aqua4Plus displays collected data in both a tabular format and a graphing format.
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Displaying Data in Tabular Format:

Figure 10: File Display Window

Click on the file display icon  (or View Menu | File Display Window) to open the File
Display Window. This window displays data that has been uploaded to a disk file (files
with an extension of .a4d). To view a file, click the file open icon   (or File Menu |
Open.) Navigate to the desired file, and then click the Open button.

The File Display Window consists of two panels. The top panel displays various
information about your data, such as number of records, session name, sensor name,
etc.

The lower panel displays the actual data. The first few rows display statistical data
about your records, including minimum, maximum and mean values for both pressure
and temperature, as well as the variance, standard deviation, and field calibration values.
The remaining rows display the actual data.

To print your data, click the File menu and select Print. Be warned - large files will
consume large amounts of paper!

Click on the graph icon  to switch to graphing view. You can switch back to the
tabular view by clicking on the file display icon .
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Displaying Data in Graphing Format:

Figure 11: Graphing Window

Click on the graphing icon  (or View Menu | File Graphing Window) to open the
Graphing Window. This window displays data that has been uploaded to a disk file (files
with an extension of .a4d). To view a file, click the file open icon   (or File Menu |
Open.) Navigate to the desired file, and then click the Open button.

The graphing window is a free-floating window and can be placed outside the main
Aqua4Plus window frame. It is often easier to view the graph with the graphing window
maximized. Click the maximize button  in the upper right corner of the graphing
window to view in maximized mode.

Click to open a new file. (Alternate = File Menu | Open)

Click to export the graph as a graphic file (.jpg, .gif, .bmp, or .png).
(Alternate = File Menu | Export Graph)

Click to print the graph. What is seen on the screen will be printed – i.e., if
notes or statistics are turned on, they will print. If the graph is zoomed in, it will
print only the area showing on the screen.
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Click to copy and paste to the Window’s clipboard. When pasting from the
clipboard into another program, exactly what is pasted will depend on the type
of program. If pasting into a graphics or paint program, only the graph will
paste. If pasting into a text only program, such as Notepad, only the notes and
statistics (if turned on) will paste. If pasting to a multi-purpose program, such
as Word, everything that is turned on will paste.

Click to open the Display Setup dialog box and change various display
attributes.

Figure 12: Graph Display Setup

1. Parameter - Lists all parameters available to be plotted for the
particular data file.

2. Plot - Click to toggle whether or not to plot any particular
parameter. Note: Time is always plotted and is always
along the bottom.

3. Legend Position- The legend for any parameter (except Time) can be
displayed either to the left or to the right of the graph.
Click here to toggle between left and right.

4. Scale Limits - Click to rotate among the following options:
• Full Scale - Minimum and Maximum scales set to full scale for that

parameter on the sensor whose data is being displayed.
• Data - Minimum and Maximum scales set to minimum and

maximum data values for that parameter in the displayed
data file.

• User - User defined Minimum and Maximum scales.
5. Scale Min/Max - Displays current Minimum and Maximum scale values.

Click and type in these boxes to change values for User
defined scales.

6. Grid Line - Enable grid lines for any particular parameter
7. Plot Color - Click to change color for any particular parameter
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Click to add notes to your graph. You can add up to 500 words below the
graph. If this button is selected, they will be printed with the graph and can be
copied and pasted into other documents. (See note at  on previous page
about limitations on copying and pasting.)

Click to display statistics below the graph (min, max, mean, variance, standard
deviation, and field calibration values). If this button is selected, they will be
printed with the graph and can be copied and pasted into other documents.
(See note at  on previous page about limitations on copying and pasting.)

Click to turn grid lines on or off.

Click to turn discrete points on or off.

Click to change from color to black and white. Some printers print better in plain
black and white.

Click to change the size, color, and style of the font. Note that size and style
affect all fonts on the graph, while color affects only the title.

Click to zoom in. Cursor will change to an arrow with an attached box. Click and
drag to enclose the area you want to zoom.

Click the down arrow to right of icon to select scale:
• Full Scale - Minimum and Maximum scales set to full scale for ALL

parameters on the sensor whose data is being displayed.
(Set individual parameters, if desired, under Display
Setup .

• Data - Minimum and Maximum scales set to minimum and
maximum data values for ALL parameters in the displayed
data file. (Set individual parameters, if desired, under
Display Setup .

• User - Select the user defined Minimum and Maximum scales
specified under Display Setup .

On the main Aqua4Plus menu, click on the file display icon  to switch to the tabular
view. You can switch back to the graphing view by clicking on the graphing icon .

Exporting Data

• Using the File Display window, open the file you want to export.
• Click on the   tool button.
• Select a file location and enter a name for the file or leave as is to accept the

current file name.
• Select a file type. Files can be saved in either Text (.csv) or Excel (.xls) formats.
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Select the file type from the drop-down Save-as-type box. (.xls formatted files
can be opened in Excel. .csv formatted files can be opened in Excel and most
other popular spreadsheets, databases, and word processors.)

• Click Save. You will be given the option of viewing it in Excel. (Note, you must
have Excel installed on your machine in order to make use of this option.)

Importing Data Into a Spreadsheet

To import data to a spreadsheet or database, you must first Upload or Export the data to
a .csv or .xls file. (See previous sections on uploading and exporting.) Most spread-
sheets and databases can readily import .csv files. Microsoft® Excel can import either
.csv or .xls files.  Following are instructions for importing a data file into Excel. For
importing into other programs, see documentation with the particular program.

1. Open Excel.
2. Click on the File menu, and the select Open.
3. On the Open dialog box, click the down-arrow to the right of the Files of Type

field. (This is the last field on the dialog box.)
4. Click the option All Files.
5. Navigate to the saved file, and then click the Open button in the lower right

corner of the dialog box.

The data will be opened in Excel. (Note: While Aqua4Plus can handle over 130,000
records, Excel is limited to approximately 65,000 records.)



20
Additional Material on CD

The following additional material is available on the CD supplied with this manual.
Much of it is also available for download from our web site at
www.inwusa.com/appnotes.htm. If you would like printed copies contact INW at
1-800-776-9355.

Adobe Acrobat Reader is required to view all documents in PDF format. If you do not
have Adobe Acrobat, please visit their web site at http://www.adobe.com for a free
downloadable reader.

Aqua4Plus Materials

Aqua4Plus Instruction Manual (this manual)
(aqua4plus_manual.pdf)

Using USB-to-Serial Cables to Connect AquiStar® Smart Sensors to PC or Laptop
Computers  (usb_serial-9C0153.pdf)

 An alternative for computers that do not have available serial ports but need a
means to connect to AquiStar® Smart Sensors.

Barometric Compensation Utility
(barometric_9B740ADD-1.pdf)

This addendum explains the Barometric Compensation Utility, which adjusts the
data from an absolute pressure sensor by using a data file from a barometric
sensor.

Cellular and Land-Line Coummunication
(cellular_9B740ADD-2.pdf)

The addendum give details on using Aqua4Plus with cellular or land-line
modems.

PT2X Smart Sensor Materials

PT2X Instruction Manual
(pt2x_manual.pdf)

Changing Batteries in the AquiStar® PT2X Smart Sensor
(pt2x_changing_batteries.pdf)

This application note details the steps for changing batteries in the PT2X.
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Converting Raw Data from PT2X and Applying Calibration Values
(pt2x_converting_raw_data.pdf)

This application note provides details for converting the PT2X raw data into
pressure and temperature data and details on applying calibration values to that
data. It is aimed at those who want to access the PT2X data without the use of
INW's free Aqua4Plus software.

Error Compensation on PT2X Smart Sensors (pt2x_calibration.pdf)
This application note explains the patented method used by INW to transform
basic strain gauge pressure readings into highly accurate, temperature and device
compensated data.

Configuring an AquiStar® PT2X Smart Sensor to Monitor Depth-to-Water or Ground-
water Elevation (pt2x_grndwtr_elevation-9C0152.pdf)

This application note provides simple examples for configuring a PT2X Smart
Sensor for monitoring depth-to-water or groundwater elevation, using the
Aqua4Plus Control Software.

Variable Interval Continuous Sampling (pt2x_variable_continuous-9B0740ADD-3.pdf)
The AquiStar PT2X has a continuous sampling mode. By default, using this mode
will record samples at the rate of 10 per second.  The purpose of this addendum is
to give details on how to change the default sampling rate.

TempHion Smart Sensor Materials

TempHion Smart pH Sensor Instruction Manual
(TempHion_pH_manual-9B0810.pdf)

TempHion pH Field Calibration Instructions
(TempHion_pH_FieldCal-9B0811.pdf)
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SOFTWARE LICENSE & LIMITED WARRANTY/DISCLAIMER
- Aqua4Plus

SOFTWARE LICENSE. The seller grants the user a non-exclusive license to use
Aqua4Plus (hereafter known as the software), according to the following limitations and
conditions.

The user may install  Aqua4Plus on one or more desktop or laptop computers. All title
and intellectual rights to the software are owned by the seller. No copies may be made or
distributed except as described above. The user may not modify or reverse engineer the
software.

A.   LIMITED WARRANTY. Seller warrants that the software will substantially perform
the functions described in the accompanying written materials for a period of ninety (90)
days from the date of receipt. If the software does not conform to the foregoing war-
ranty, Seller shall, at Seller’s sole and exclusive option, repair or replace the software or
refund to the user a prorated portion of the license fee paid.

Seller warrants that any hardware accompanying the software will be free from defects in
materials and workmanship under normal use and service for a period of one (1) year
from the date of receipt. Seller’s obligation under this warranty shall be limited to
replacing or repairing the part or parts or, at Seller’s option, the products which prove
defective in material or workmanship within ONE (1) year from the date of delivery,
provided that Buyer gives Seller prompt notice of any defect or failure and satisfactory
proof thereof.   Any defective part or parts must be returned to Seller’s factory or to an
authorized service center for inspection.   Buyer will prepay all freight charges to return
any products to Seller’s factory, or any other repair facility designated by Seller.   Seller
will deliver replacements for defective products to Buyer (ground freight prepaid) to the
destination provided in the original order.   Products returned to Seller for which Seller
provides replacement under this warranty shall become the property of Seller.

Seller’s obligations under this warranty shall not apply to any product with (a) is
normally consumed in operation, or (b) has a normal life inherently shorter than the
warranty period stated herein.

In the event that equipment is altered or repaired by the Buyer without prior written approval by
the Seller, all warranties are void.   Equipment and accessories not manufactured by the Seller are
warranted only to the extent of and by the original manufacturer’s warranty.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES,
WHETHER ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY.   IMPLIED
WARRANTIES OF FITNESS AND MERCHANTABILITY SHALL NOT APPLY.   SELLER’S
WARRANTY OBLIGATIONS AND BUYER’S REMEDIES THEREUNDER (EXCEPT AS
TO TITLE) ARE SOLELY AND EXCLUSIVELY AS STATED HEREIN.   IN NO CASE WILL
SELLER BE LIABLE FOR CONSEQUENTIAL DAMAGES, LABOR PERFORMED IN
CONNECTION WITH REMOVAL AND REPLACEMENT OF THE SENSOR SYSTEM,
LOSS OF PRODUCTION OR ANY OTHER LOSS INCURRED BECAUSE OF INTERRUP-
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TION OF SERVICE.   A NEW WARRANTY PERIOD SHALL NOT BE ESTABLISHED FOR
REPAIRED OR REPLACED MATERIAL, PRODUCTS OR SUPPLIES.   SUCH ITEMS
SHALL REMAIN UNDER WARRANTY ONLY FOR THE REMAINDER OF THE WAR-
RANTY PERIOD ON THE ORIGINAL MATERIALS, PRODUCTS OR SUPPLIES.

B.   With respect to products purchased by consumers in the United States for personal use, the
implied warranties including but not limited to the warranties of merchantability and fitness for a
particular purpose, are limited to twelve (12) months from the date of delivery.

Some states do not allow limitations on the duration of an implied warranty, so the above
limitation may not apply to you.   Similarly, some states do not allow the exclusion or limitation
of consequential damages, so the above limitation or exclusion may not apply to you.   This
limited warranty gives you specific legal rights; however, you may also have other rights which
may vary from state to state.



24
Reordering Information

For sales & service offices, please contact:

Instrumentation Northwest, Inc.
www.inwusa.com

800-776-9355
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